
mand line,
simply by typing

its name. This article
used version 2.2.0 of the

Eye of GNOME, which is included
in the SuSE 8.2 distribution; the com-
mand is eog &.

Usually, a suitable entry can be found
in the desktop environment menu, (SuSE
e.g. Graphics/View/Eye of GNOME Image
Viewer), but you need to use the com-
mand line to open multiple images.

eog *.[Jj][Pp]* & opens all the JPEG
files in the current working directory –
putting each image and a menu in its
own window. This can quickly lead to a
cluttered desktop in the case of larger
photo albums.

All tools focus on their own windows:
the View menu with Zoom In, Zoom Out,
tools for enlarging or minimizing as well
as Normal Size and Best Fit for getting
the optimal size for the viewer window.
Alternatively, you can access these tools
using the appropriate icons on the tool-
bar. View/Full Screen enlarges the image
to encompass the entire screen and hide
the menu. To return to the previous view
hit the [Esc] key.

The Edit menu allows you to mirror 
an image (Flip Horizontal and Flip Verti-
cal), or rotate it using Rotate Clockwise

to rotate the image 90 degrees to the
right, and Rotate Counter Clockwise to
rotate to the left.

This still leaves the Preferences menu
entry. Here you will find the folder tab
Image Viewer where the Interpolate
image on zoom setting is enabled. This
uses interpolation to provide better res-
olution when scaling images. Indicate
Transparency sets the background color
for transparent images.

The help menu Help/Contents gives a
detailed description of the (as yet not
implemented) Dither function, or the
interpolation algorithm. It is nice, as a
user, to be informed about the intentions
of the programmers, although it is a little
bit confusing.

Show and (Camera) Selection
Those of you who don’t need the func-
tionality of Eye of GNOME when using
KDE, can always use the trivial kview
viewer from the kdegraphics package.
Fortunately, you don’t have to put up
with kview, as two other quite different
programs, 

Digikam and PixiePlus, are available,
though not installed by default. Interest-
ingly enough, both programs use a
traditional three panel approach to the
user interface.

When we refer to Digikam (http://
sourceforge.net/projects/digikam), we
mean version 5.0.1 that comes with
SuSE 8.2. Entering digikam & at the

It is no wonder that in certain cate-
gories there is an abundance of
programs. This includes text editors,

address books, or image viewers such as
Eye of GNOME, Digikam, PixiePlus, xv,
xnview – the list could go on and on. But
even the choice of programs for this
article shows how vastly the
programs in this category
differ.

Although they all achieve
the lowest common denomi-
nator, that is displaying
images in the most common
bitmap formats PNG, GIF and for
the photography fan, the indis-
pensable JPEG, Digikam fails to
make the grade with TIFF and BMP.
Only Pixie can handle the WMF format,
while xnview can display any number of
exotic formats. Apart from that, it is up
the user to decide which viewers will be
useful, depending on the tools they offer,
and the problem at hand.

The Eye of GNOME (http://www.
gnome.org/softwaremap/projects/eog) is
a small, compact image viewer for every-
one needing a fast, simple viewer.

If you need a slide show or a digital
camera control tool, you would probably
opt for Digikam. The PixiePlus, vnview,
and xv programs offer most of the func-
tionality you would expect of image
editing programs; PixiePlus also provides
a file manager function and a less-than-
intuitive user interface.

The Eye of GNOME
The award for the most innovative pro-
gram in this article goes to Eye of
GNOME (see Figure 1). This creative
award was made however, while ignor-
ing the rule of thumb that almost every
program can be started from the com-

It seems that whenever you are looking through a photo archive, you tend to

try one image viewer after another. And while no two are the same, you even-

tually go looking for some help in order to make a choice. BY UTE HERTZOG

A comparison of image viewers

Images, Images, Images
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command line will start the program.
The SuSE distribution places Digikam in
Multimedia/Video/Digikam, for some
unknown reason, rather than grouping it
with the other image viewers.

The program reads digital photos from
a camera, but not from video cameras,
and displays information on the plug-&-
play hardware it has recognized below
the directory in the lower left part of the
main window (see Figure 2).

A new camera can be configured using
Configure/Setup and the Camera Settings
tab, where you will discover a large
selection of supported camera models.
Camera allows you to connect to the
camera. You can use the menu to down-
load photos from (or upload to) the
camera – either all of them, or those
selected using the [Ctrl] or [Shift] key in
conjunction with the left mouse button.

Digikam organizes images in albums
that you can create using Album/
New Album. By default, Digikam
assumes your home directory as the
standard directory. You can easily
change this setting using the menu entry
Configure/Setup/General Settings in the
Set Album Path field. After copying

images in the usual graphical formats to
this directory (and selecting the direc-
tory), thumbnails are shown in the
right-hand panel of the window, and
unlike Konqueror, Digikam suppresses
all non-graphic files.

If you only see small squares instead
of images, then deactivate the option
Pause Thumbnail Generation in the
Albums menu; this is the default setting
when opening a directory with a lot of
graphic image files. 

As generating images requires a lot 
of computer resources, the computer
might hang. The Configure/Setup/
General Settings menu entry (see Figure
3) allows you to adjust the thumbnail
size, amongst other things.

When you double click a thumbnail,
Digikam displays the original size image,
using the built-in viewer, if the option
Use Inbuilt Image Viewer in General Set-
tings is enabled. Alternative viewers can
be chosen, for example PixiePlus,
KIconEdit, Kuickshow or Kview.

Album/Delete Album deletes the
selected directory. But be careful: even if
there is nothing on display in the right-
hand panel, it doesn’t necessarily mean
that the directory is empty.

Like to make a slide show with the
images in an album? To do so, select 
the images you need to entertain your
audience, and then click on Album/
Slideshow. If you don’t select any

images, then Digikam will show every-
thing. Clicking on an image during the
show will call up a menu with the Pause
and Exit functions. To carry on with the
slide show, first hit the [Esc] key and
then click with your mouse.

In General Settings (see Figure3), you
can determine how many seconds to
wait before displaying each image, and
optionally specify a transition effect that
blends the images from top to bottom,
when changing images. Would you like
to know the name of each image as it is
shown? The option Show Filenames in
SlideShow will display the name either at
the top (At Top) or bottom (At Bottom)
of the image.

The Image Viewer as a File
Manager
The fact that the programmers of
Digikam do not regard the PixiePlus
image viewer as a competitor – and, as
shown above – even allow you to inte-
grate PixiePlus as an external viewer is
ample evidence that these programs
were designed with different tasks in
mind. If the program is not included in
your distribution (SuSE 8.2 includes ver-
sion 0.5.0, which we used for the current
article), you can download program at
http://www.mosfet.org/pixie/download.
html. Launch the program by typing
pixie & or use the menu item Graphic/
View/PixiePlus Image Manager.
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Figure 1: The Eye of GNOME image viewer

Interpolation: recalculates the surrounding
pixels when enlarging an image.The result
can be an image with a higher resolution, but
with a weaker color depth.
Dithering: Images with a lower number of
colors tend to have harsh step artifacts in
color gradients.The dithering tool reduces
this undesirable effect by using a smaller grid
to smooth the color gradient.
Thumbnail: A small image used for preview-
ing graphic files, which requires less memory
and can therefore be loaded more quickly.

GLOSSARY

Figure 2: Images as viewed with Digikam



interesting manipulation
tools. For example, you can
change the file permissions
of selected files.

The entries in the
Edit/Convert to menu
looked promising for files
that need to be converted to
others formats, however,
they were a disappointment
in that nothing happened
when they were used.

Presentation help
The existence of Digikam
does not prevent PixiePlus
from offering its own slide
show, located under Files/
Slide Show, which not only
displays the images in the

current directory or those found in the
Files tab, but also the images you viewed
last. You also have the option of setting
the slide delay time in the Slide Show
menu, to keep repeating the show by
putting it in a Loop, or selecting special
transitional effects, as well as setting the
time between shows.

The Files/Make Web Image Gallery
menu entry provides a tool for present-
ing images on the Web. The wizard that
is launched when you select this entry
helps you with the various settings, such
as page and thumbnail sizes, frame style,
layout, image name display, navigation
buttons, the document titles, and HTML
color schemes for the background, text
and links. Clicking the Finish button will
produce a HTML page with all of the
thumbnails, that can be opened by dou-
ble clicking on it in Konqueror (see
Figure 5).

Need a screen-
shot from a pro-
gram? With File/
Take a Screenshot
you can set a win-
dow and decide 
if you want a
screenshot of the
window or of 
the entire desktop,
and if Pixie should
fade into the back-
ground for the
screenshot. After
entering the delay
time, the program

will wait to show the chosen screenshot,
and then ask if you want to save it.

The Whole Enchilada
Pixie shows its full capabilities when it
comes to processing multiple images
simultaneously. When you select the
Edit/Batch Effects menu entry, your
changes are applied to all the images you
selected by [Ctrl] clicking them.

The menu has four items: Transform
can scale an image, mirror it either hori-
zontally or vertically, and rotate it in 90
degree steps. The Enhance item allows
you to brighten up the image, or apply a
color filter (Equalize or Normalize) There
is also the Invert feature and an option to
convert to a grayscale image.

Using on the standard effects found in
Edit / Batch Effects /Normal Effects you
can add text or a border to an image.
Pixie always asks if you would like a pre-
view of your changes, and then inquires
if they should be carried out or ignored.

You can also add background noise
(Noise), convert the image to a relief,
sharpen the image (Sharpen) or blur it
(Blur). You can also use frame highlight-
ing and the Spread function, which
spreads out the pixels to make the image
appear “washed out”, or functions for
adding shadows to graphic images. The
special effects in the Edit / Special Effects
menu include a Solarize entry that
makes a negative image, as well as the
Swirl, Implode or Wave functions that
distort the image in different ways. Oil
Paint makes the image look like an oil
painting, whereas Charcoal Draw does
what the name implies, that is makes a
kind of charcoal drawing.

In the upper left hand corner you can
use the three folder tabs to locate a direc-
tory with the most recently opened files,
or your Hotlist. The latter contains direc-
tories, that you need the most. Thus, you
can use the Edit menu entry to create a
hotlist, much like you would use book-
marks in your browser. As an alternative,
you can use the plus symbol in the tab to
add entries, or the minus symbol to
remove them.

The main menu contains lots of detail.
You can enable View/Link directory tree
to browser, to display directory contents
in the panel on the right, when using the
navigation bar in the Folders tab to
switch between different directories.
Pixie, unlike Digikam, displays not only
graphic files, but the complete contents
of the chosen directory with appropriate
icons. You can click on Create Thumb-
nails to display thumbnails instead of
icons.

A preview, lower left, can be obtained
simply by clicking on a graphic file. A
double click expands the file to its full
size with its own menu bar, which you
can then use to switch between directo-
ries, or adjust the brightness or contrast
of the chosen image. You can also rotate
the image or resize it. Just click any-
where on the image to end the process.

You can use the View menu to sort the
files in almost anyway you like, set pre-
views for text and office files, or adjust
the size of the thumbnails.

The Edit menu offers standard select,
copy, and delete tools, as well as a few
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Figure 3: Configuring Digikam

Figure 4: Thumbnails in PixiePlus



The File menu also offers
the possibility to organize
large numbers of images 
or photos: Create / Edit File
Categories creates categories,
that you can assign to a group
of selected images, simply by
selecting Categories / Add to
Category in the shortcut
menu, after right clicking the
image or selected images.
The Show only Categories
button in the tool bar, does
just that; it shows all images
of a chosen category.

If there are copies of an
image in different formats,
then Pixie can use the Files /
Find Similar Images menu
item to find them; this func-
tion looks for similarities of
more than 90% between images.

Old But Not Forgotten
The most famous shareware appli-

cation for Linux is called xv (http://
www.trilon.com/xv/downloads.html)
and though it has been at version 3.10a
for donkey’s years, it still has a large user
following. It is still free for private use,
and can be launched from the command
line by typing xv file_name &. It can also
be used commercially for free as long as
it is not used on anything directly related
to your job.

If you launch the program without any
parameters, or by selecting a menu entry
(such as Graphic/Viewers/xv with SuSE
8.2), you can right click on the window
to access the xv Controls user interface.
Click the Load button on the right to
choose a single image, or select Load all,
to load all the files in the current direc-
tory into the file list in xv controls. The
latter is naturally designed for directories
that contain graphic format only. This
list can be extended by adding new files
to the directory at any time.

You can view an image by double
clicking the image name (see Figure 8)
and use Next or Previous to browse the
list.

Clicking the Algorithms button opens
a menu for graphic processing. To
choose a tool, left click and hold the
mouse button on the entry until the
desired tool appears, for example Blur,
which – just like PixiePlus – blurs an

image to the point where small lettering
again becomes legible. Or use Sharpen to
sharpen the focus, Emboss to create
relief, Edge Detect to sharpen the edges
or Oil Painting to make the image look as
if it was painted in oils. Pixelize reduces
the image to individual pixels, and
DeSpeckle allows the colors to run
together.

The menu for the Display button con-
tains tools for dithering and smoothing
(Smooth), furthermore the color palette
is edited here.

The menu entry 24/8 Bit specifies a
high color resolution (24 bit depth), or
an indexed one of 8 bit, or allows you to
reduce a 24 bit image to one of 8 bits.
The size of an image can be adjusted in
the menu Image Size, for example dou-
bling the size (Double Size) or reducing
the size by 10% (10% Smaller).

The toolbar at the bottom of the xv
controls has duplicates of the tools
described above as well as several others
such as copy or cut. Text can be added to
an image using the A button. First you
must define a window for the text by
dragging the mouse over the image area
while holding down the left button and
then clicking on the A button to activate
the tool, and finally entering the text to
be inserted.

The Grab button can be used for cap-
turing screenshots, and offers a similar
functionality to that provided by Pixie. If
you start the screenshot by clicking the
AutoGrab button, then the computer

beeps after a short while, and
produces a screenshot at the
mouse cursor (or of the
entire screen accordingly). If
you select Grab, the desired
screenshot appears only after
you click on the window you
want to grab.

The menu accessed via the
Windows button contains
other tools, such as a Color
Editor. Image Info displays
data about the focused image
and Image Comments allows
you to add notes to the image
data.

Those of you not using
KDE can click the Root but-
ton to decorate your back-
ground with the current
image. If you wish, you can

tile or mirror the image (Root:mirrored).
You can also control xv using hot keys

as indicated by each menu entry, or the
menu list Windows / XV Keyboard Help.

xnview
Due to restrictive licensing, SuSE users
will have to download the RPM for the
fifth viewer, xnview 1.50 from http://
perso.wanadoo.fr/pierre.g/xnview/
enhome.html, and install it, for example
by clicking on the rpm in Konqueror.
Having done this, you can then launch
the program in a terminal window by
typing xnview &. This opens a small
menu with three entries, where you can
use File / Open, to search the current
directory for images. xnview shows all
files by default, but you can use FileType
to limit this by specifying files with a cer-
tain extension. xnview maintains image
information for each file, and also a pre-
view, if required. The image can be
called up by double clicking it (see
Figure 7).

File/Browse starts a browser mode
with a user interface that is divided into
three panels. The upper left panel con-
tains the directory tree, the upper right
shows the contents of the current direc-
tory, where you can select the desired
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Invert: The colors are swapped with their
complementary colors, that is white to black,
red to green, orange to blue and back again.
The result is a negative of the original image.

GLOSSARY

Figure 5: Photo albums on the Web



pixel representation, which is no longer
recognizable. When running the slide
show automatically, the images shown
are very small. You need to click on each
image during the slide show in order to
scale the images up to a reasonable size
for viewing.

A list of selected files can be edited in
the same way using the Tools / Multi
Convert menu. In the corresponding dia-
log box, you can select the files to be
converted by clicking the Add button,

then declare them as Input. Then use
Output to specify the target directory and
the desired editing steps. The steps are
listed by clicking the Advanced Opera-
tions button. Save Script saves the whole
process as a small script file that can be
used at any future time.

As well as functions for converting 
to other graphic formats, the Tools /
Multi Convert menu contains entries that
influence the toolbar, or slideshow
options.

Get the Picture?
Although this article cannot hope to
have any effect on the large number of
programs available, we do hope that it
will make your choice easier. If all you
need is a simple image viewer, the Eye of
GNOME is a good choice.

Perhaps you have a digital camera
with a large memory, that you want to
download to your computer? Digikam is
recommended in this case. Or perhaps
you prefer a well-tested, reliable program
with lots of functions? In this case you
should opt for xv.

Do you regularly convert lots of
graphic images from one format to an
other? xnview offers a good tool for this,
and can even be scripted. Or do you
want an image viewer with a lot of func-
tions, and no headaches? Then PixiePlus
would be your choice. But in the end,
the choice is yours. ■

image to view it in the bottom panel.
Alternatively, a new image window can
be opened by double clicking on an
image name.

The menu Image provides image pro-
cessing tools for converting to grayscale
or using alternative color palettes. Rotate
rotates, while Flip mirrors the image.
Adjust is used to adjust the contrast,
brightness and so on. Map has tools
such as solarize, as described for Pixie,
and Swap is used to manipulate RGB
information, which has the same effect
as a color filter. The Filter menu offers
tools such as Blur, Enhance, Edges and
Effects/Oil Painting...

The screenshot tool Tools / Capture
leaves a lot to be desired when compared
to the other viewers. When you create a
screenshot of the entire desktop, the
screenshot will include the xnview dialog
box. The Select a Window tool, that grabs
windows by name is in itself a good idea,
but it needs some work especially with
regard to its stability on SuSE 8.2.

This also applies to Tools / Slide Show
tools. A time delay between images in a
slide show can be set, and you can also
create repeating slideshows using Loop,
but this area is buggy. This is especially
true of the many extra options, located
under More Options, not all of which are
easily intelligible. Even though it is pos-
sible to enlarge the image to fit the entire
screen, it mutates to an image with large
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Figure 6:Viewing images with xv

Figure 7:The xnview image viewer


